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Learn more

This guide and other resources for SMART Document Camera 5550 are available 
in the Support section of the SMART website (smarttech.com/support). Scan this 
QR code to view these resources on your mobile device.

FCC warning
This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide 
reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio 
frequency energy and, if not installed and used in accordance with the manufacturer’s instructions, may cause harmful interference to radio communications. Operation of 
this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his own expense.

Trademark notice
SMART Board, smarttech, the SMART logo and all SMART taglines are trademarks or registered trademarks of SMART Technologies ULC in the U.S. and/or other countries. All 
third-party product and company names may be trademarks of their respective owners.

Copyright notice
© 2022 SMART Technologies ULC. All rights reserved. No part of this publication may be reproduced, transmitted, transcribed, stored in a retrieval system or translated into 
any language in any form by any means without the prior written consent of SMART Technologies ULC. Information in this manual is subject to change without notice and does 
not represent a commitment on the part of SMART.
This product and/or use thereof is covered by one or more of the following U.S. patents:
www.smarttech.com/patents
March 30, 2022

https://www.smarttech.com/support
https://www.smarttech.com/patents
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Important information

Caution 

 l Place your SMART product on a solid surface to prevent it from falling. 

 l If you have a security cable attached to your SMART product, do not carry or swing your SMART 
product by the security cable.

 l Do not connect non-shielded interface cables to your SMART product and do no leave cables 
connected to unused connectors, because this can cause interference level that exceed FCC 
regulations. 

 l Avoid setting up and using the SMART product in an area with excessive levels of dust, humidity 
and smoke. 

 l Do not block or cover the opening or slots on your SMART product. These slots provide ventilation, 
ensure reliable operation and protect your SMART product from overheating. 

 l Do not carry your SMART product by the camera arm. Carry it by the base of the unit. 

 l Do not aim the camera lens at the sun. 

 l If your SMART product requires replacement parts, make sure the service technician uses 
replacement parts specified by SMART Technologies or parts with the same characteristics as the 
original. 

 l Ensure that batteries are stored in a cool and dry place.

 l Do not discard batteries in water, fire, or domestic waste. Dispose batteries at collection points. 

 l Remove the batteries in the remote control if you are not in for an extended period of time. 
Battery corrosion or leakages can damage the remote control. 

 l Do not mix new and used batteries. 

 l Do not mix different types of batteries: alkaline, nickel-cadmium (rechargeable), or carbon-zine. 
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This chapter introduces the SMART Document Camera™ 550.

About this guide
This guide is for users who set up and use the SMART Document Camera 550 in their organizations. 

It includes information on the document camera’s on-screen display menu, remote control, and basic 
troubleshooting. 

Features
The SMART Document Camera 550 can transform any classroom or lecture hall into a collaborative and 
interactive learning environment. The document camera enables you to capture and display printed 
documents, microscope slides, videos, and 3D objects on your computer, projector or display panel.

The document camera includes the following features:
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Feature Feature

Camera  l High resolution CMOS sensor
 l 12X digital zoom
 l Up to 30 frames per second
 l Automatic or manual focus
 l Maximum shooting area 17 4/8" x 9 6/8"

Output/input  l HDMI 1080p @ 50 Hz / 60  Hz, 720p @ 50 Hz / 60 Hz, 1024 × 768p @ 
60 Hz

 l USB mini-B (connect to computer)
 l WiFi 
 l SD memory card
 l Internal memory

Physical construction  l Built-in battery
 l Built-in LED illumination lamp
 l Security lock slot 
 l Flexible arm
 l Microphone integrated into base

Software  l SMART Notebook® collaborative learning software
 l SMART Document Camera software
 l SMART Product Drivers

Image and video storage  l Supports SD/SDHC cards (maximum 32 GB)
 l Supports USB mass storage mode for internal memory and SD card

For more information, see the SMART Document Camera 550 specifications (smarttech.com/kb/171224).

https://smarttech.com/kb/171224
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Components
The SMART Document Camera has a flexible arm to position the lens at any angle. The camera head 
has LED overhead lighting to enhance lighting conditions.

The SMART Document Camera 550 consists of the following components:

No. Name

1 Camera head

2 Camera lens

3 LED light

4 Camera arm

5 Control panel
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Control panel

The control panel to enables you to switch between Camera, Computer Pass-Through, and Playback 
modes. Additionally, using the control panel allows you to adjust the settings and features in the Camera 
mode’s on-screen display (OSD) menu.

The control panel of the document camera consists of the following:

No. Name More information

1 Power   Power ON/OFF the document camera

2 WiFi/USB mode   Switch between WiFi and USB mode

3 Camera/PC mode   Switch the video signal between a computer and camera with the 
use of the HDMI IN port 

4 Brightness 
decrease

  Decrease the level of brightness when capturing a live images

5 Lamp   Power ON/OFF the overhead light

6 Freeze/Stop  l Pause or resume an image frame in Camera mode
 l Stop video playback in Playback mode
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No. Name More information

7 Navigation arrows  l Access options from the OSD menu

 l Adjust the volume of a video play back by using  and

 l Fast-forward to rewind a video by using  and

8 Menu   Access the OSD menu

9 Recording   Start or stop recording video and audio

10 Auto-Focus  l Automatically adjust focus
 l Selection option for Playback mode and OSD menu
 l Start or pause video playback

11 Capture/Delete  l Capture an image in Camera mode
 l Delete image or video in Playback mode

12 Brightness 
increase

  Increase the level of brightness when capturing a live images

13 Playback   View captured images and videos

14 Zoom out   Decrease the image magnification in Camera and picture 
Playback mode

15 Power indicator  l Solid red: Standby
 l Flashing red: Power on
 l Solid green: HDMI output
 l Solid orange: TV output

16 WiFi connection 
indicator

 l Flashing orange: Searching for Access Point
 l Solid blue: Connected to Access Point
 l Flashing blue: Camera can be accessed wirelessly

17 Zoom in   Increase the image magnification on Camera and picture 
Playback mode

18 Battery life 
indicator 

 l Solid green: Battery is over 40%
 l Solid orange: Battery is between 20%-40%
 l Solid red: Battery is between 5%-20%
 l Flashing red: Battery is lower than 5%

19 Battery charge 
indicator

 l Solid red: Power plug is connected and battery is charging
 l Solid green: Battery is fully charged 
 l Off: Power plug is not connected
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Right panel

The right panel of the document camera consists of the following: 

No. Name More information

1 Camera holder   Holds the camera head for storage

2 SD card slot   SD/SDHC memory card slot 

3 TV-RGB switch   Switch between TV and output display video 

4 Security lock slot   Attachment for a Kensington compatible lock 

Left panel

The left panel of the document camera consists of the following: 

No. Name More information

1 RS-232   Connect to a computer serial port 

2 Speaker   Connect to an amplified speaker
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No. Name More information

3 MIC   Connect to microphone 

Note 

The built-in microphone will be disabled once the external 
microphone is connected to the document camera. 

4 Reset   Resetting the document camera will set it back to standby mode

Rear panel

The rear panel of the document camera consists of the following connectors: 

No. Name More information 

1 DC 12V   Connect the power adapter

2 WiFi dongle port   Connect the WiFi dongle

3 HDMI IN   Connect to an external HDMI source

4 HDMI OUT  l Connect as an output video signal to a monitor or projector
 l HDMI OUT is used to transmit high definition images

5 TV OUT  l Connect to a device with a TV output
 l TV OUT is used to transmit standard definition images

6 USB mini-B   Connect to a computer
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Remote control

All features of the SMART Document Camera 550 can be accessed with the remote control. The remote 
control requires two AAA batteries.

No. Name More information 

1 Power   Power ON/OFF the document camera 

2 Camera   Camera mode displays the video signal from the document 
camera 

3 Record   Start or stop recording video and audio

4 Capture   Capture still image in Camera mode. When in continuous capture 
mode, press this button again to stop

5 Visor   Hide parts of the presentation screen

6 Rotate   Rotate an image in Camera or Playback mode

7 Menu   Access the OSD menu
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No. Name More information 

8 Navigate arrows  l Adjust the volume of a video play back by using  and
 l Fast-forward to rewind a video by using  and
 l Adjust the spotlight frame and visor screen coverage

9 Auto-focus   Automatically adjust focus

10 Zoom In/Out   Increase or decrease the image magnification on camera and 
picture Playback mode

11 Zoom reset   Reset zoom default magnification to 100%

12 Playback   View captured images and videos

13 PC 1/2   Displays the video signal from HDMI input of the document 
camera

14 Freeze/Stop  l Pause or resume an image frame in Camera mode
 l Stop video playback in Playback mode

15 Spotlight   Adjust the size, shade, and color of the spotlight 

16 Split screen   Displays a split screen. One side displays live image from the 
camera and the other side displays thumbnails of images/video

17 Mode   Switch between text, graphics and microscope mode

18 Timer   Select timer duration

19 Video playback  l Make a selection in Playback mode and OSD menu
 l Play/Pause video playback

20 Lamp   Power ON/OFF the overhead light

21 Brightness   Increase or decrease the level of brightness when capturing a live 
images

22 Default   Reset back to factory default settings

23 Delete   Delete image or video in Playback mode

Power adapter
Your document camera comes with a power adapter, including a country specific connector that 
connects to the external power supply. Plug adapters are available for Australia, Europe, and North 
America.
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USB cable
Use the USB cable to connect your document camera to your computer. You can display objects, 
capture images to SMART Notebook files, and control your document camera from SMART Notebook 
software.

See the Troubleshooting and extending USB 2.0 and USB 3.0 connection knowledge base article for 
more information.

WiFi dongle
Use the WiFi dongle to connect your document camera to the network. 

Microscope adapter
Your document camera comes with a microscope adapter along with two different sized rubber 
couplers for the microscope eyepiece. 

Anti-glare sheet
Place the anti-glare sheet over printed documents to reduce glare. 

Modes
Your document camera has three modes you can use to control how data is sent to a computer, 
projector, monitor, or display.

 l Camera mode controls your document camera from the control panel and displays images on a 
projector, monitor, or display. 

 l Computer Pass-Through mode displays the video signal from the HDMI input on a projector, 
monitor, or display.

 l Playback mode lets you control your document camera from the Control Panel and displays image 
from an SD/SDHC card or USB drive on a connected projector, monitor, or display.

Software
Before using your document camera, download the required software to get the most out of your 
document camera.

Important 

 l Before connecting your document camera to a computer, ensure the latest versions of SMART 
Notebook and SMART Product Drivers are installed.

https://kb.smarttech.com/articles/TROUBLESHOOTING/Troubleshooting-the-USB-2-0-and-USB-3-0-connection-to-your-SMART-interactive-display?q=usb+extend&l=en_US&fs=Search&pn=1
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 l The document camera is only compatible with SMART Notebook software through a wired 
connection.

 l The SMART Document Camera software can be used through both a wireless and wired 
connection.

SMART Notebook software and SMART Product Drivers
SMART Notebook collaborative learning software and SMART Product Drivers are required for the full 
functionality of the document camera. SMART Notebook software is  a presentation tool that displays 
content captured by the document camera, and SMART Product Drivers enables the touch features of a 
SMART Board® interactive display, creating an interactive learning environment when a display is 
connected to the document camera. 

Find system requirements for your computer in SMART Notebook software 18 release notes 
(smarttech.com/kb/171298).

Notes 

 l For more information about downloading SMART Notebook software, see the Installing and 
maintaining SMART Notebook 18 support page.

 l For more information about downloading SMART Product Drivers, see the Installing and 
maintaining SMART Product Drivers 12 support page.

Download SMART Document Camera software
 1. Go to smarttech.com/software.

 2. Select SMART Document Camera software for SMART Document Camera 550.

 3. Click DOWNLOAD.

 4. Save the file to a temporary location.

 5. Follow the on-screen instructions.

https://www.smarttech.com/kb/171298
https://support.smarttech.com/docs/software/notebook/notebook-18/en/installing-and-maintaining/default.cshtml
https://support.smarttech.com/docs/software/notebook/notebook-18/en/installing-and-maintaining/default.cshtml
https://support.smarttech.com/docs/software/product-drivers/product-drivers-12/en/installing-and-maintaining/
https://support.smarttech.com/docs/software/product-drivers/product-drivers-12/en/installing-and-maintaining/
https://smarttech.com/software
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This chapter explains how to set up your document camera and how to connect it to different displays 
and devices. This chapter also explains how to use external memory storage.

Setting up your document camera
This section provides instructions on setting up your SMART Document Camera.

The document camera is designed with a flexible arm that enables you to position the camera head at 
different angles.

Note 

Before setting up and connecting the document camera, ensure that all devices are powered off.
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To unfold and position your document camera

 1. Place a hand on the base of the document camera to stabilize it. 

 2. Press the camera head down, and then pull the camera arm outward and upward.

 3. Move the camera head and aim the lens at your object.

Caution 

Do not extend the camera head too far from the body, doing so can cause the unit to fall.

To connect your document camera to the power supply 

 1. Connect the power supply cable to the DC 12V port on the rear connection panel.

 2. Connect the country-specific cable to the power supply.

Caution 

Ensure the power cord is plugged into the camera as well as the wall.

 3. Connect the plug to a power outlet.

Once the power is connected, the document camera will enter standby mode.

 4. Press  to power on the document camera.
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To connect your document camera to a  computer with a USB cable

 1. Connect the USB cable to the USB port on the rear connection panel.

 2. Locate the USB connector on the computer, and connect the USB cable.

Important 

Ensure the WiFi indicator light is off before attempting to use the USB connection. If required, 
press the WiFi button on the control panel until the WiFi indicator light is off. For more information, 
see Control panel on page 9.

Note 

For more information about extending USB connections, see the Troubleshooting and extending 
USB 2.0 and USB 3.0 connection knowledge base article.

To connect your document camera to computer with an HDMI cable

 1. Connect the HDMI cable to the HDMI IN port on the rear connection panel.

 2. Locate the HDMI OUT port on the computer, and connect the HDMI cable. 

Notes 

 o Ensure the TV/RGB switch is set to RGB.

 o Use the control panel to switch the video signal to a computer, press the Camera/PC button.

 o Use the remote control to switch the video signal to a computer, press the PC 1/2 button.

Connecting to different displays
After you complete the basic connections, you are ready to connect your document camera to an 
external display, which enables you to use the Camera and Playback modes and to access the on-
screen display menu for these modes.

You can connect your document camera directly to an external display to enable the following functions:

 l Use Camera mode to view a full-screen camera image on the external display.

 l Use Playback mode to view a full-screen slide show on the external display.

Important 

 l To switch between NTSC and PAL video systems ensure your document camera is connected to 
the display using the HDMI connection. For more information on how to switch between the video 
systems see Accessing the System menu on page 43.

https://community.smarttech.com/s/article/Troubleshooting-the-USB-2-0-and-USB-3-0-connection-to-your-SMART-interactive-display?language=en_US
https://community.smarttech.com/s/article/Troubleshooting-the-USB-2-0-and-USB-3-0-connection-to-your-SMART-interactive-display?language=en_US
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 l To use your document camera with SMART Notebook software ensure your document camera is 
connected to a computer.

Setting the TV/RGB switch
The TV/RGB switch determines the display output selection.

To set the switch to RGB

  Set the switch to RGB (right)  when using an HDMI connection for signal output. 

To set the switch to TV

  Set the switch to TV (left)  when using an RCA connection for a composite output. 

Connecting to a high definition digital video display
You can connect your document camera to a high-definition digital video display or projector with an 
HDMI cable (not supplied).

To connect your document camera to a high definition digital video display

 1. Complete the basic connections. See Setting up your document camera on page 17.

Tip 

Make sure the TV/RGB switch is set to RGB.

 2. Connect an HDMI cable to your document camera’s HDMI OUT port and our display device’s HDMI 
IN port.

Connecting to a standard definition analog video display
You can also connect your document camera to a standard definition analog video display or to video 
equipment to record your presentation with an RCA cable (not supplied). 

To connect your document camera to a standard definition analog video display

 1. Complete the basic connections (see Setting up your document camera on page 17).

 2. Connect the RCA cable to your document camera’s TV OUT port.

 3. Connect the RCA cable to your TV’s VIDEO IN port.
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Turning your document camera on and off
After your completed the basic connections, you are ready to turn the document camera on and off. 

To turn on your document camera

  Press and hold the power button  on the control panel or the remote control until the power 
indicator light changes from red to green.

Note 

The document camera will take approximately a minute to turn on completely after the light 
changes to green.

To turn off your document camera

  Press and hold the power button  for three seconds on the control panel or remote control.

The power indicator light changes from solid green and then turns off.

Note 

If you press and hold the power button for less than three seconds the document camera will 
enter standby mode.
The power indicator light changes from solid green to solid red.
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Connecting to a wireless network
The document camera’s WiFi capability allows you to connect to a wireless network from anywhere in 
the classroom.

Create a collaborative learning environment where you can import and export images and videos while 
recording and sharing your lessons.

Connecting to a wireless network
Connect your document camera to WiFi and present images and videos from anywhere in the 
classroom. Before trying to connect to a wireless network, connect the WiFi dongle to the WiFi port on the 
rear panel of your document camera. 

Important 

Before setting up a WiFi connection for the first time, make sure your document camera is connected 
to a display.

To connect your document camera to a wireless network

 1. Press the WiFi button  on the control panel.

The WiFi indicator light flashes orange.

Note 

For more information on the WiFi connection indicator light, see WiFi connection indicator on 
page 10.

 2. Press the MENU button on the control panel or remote control.

The OSD menu appears on your display.

 3. Use the right arrow button  on the control panel or remote control to navigate to the WiFi tab.

 4. Select WiFi Setup and then  press  on the control panel or remote control.

The AP Settings dialog box appears.

 5. From the SSID menu select your wireless network and then press  on the control panel or remote 
control. 

 6. Use the down arrow button  on the control panel or remote to navigate to the Password field.

 7. Enter the password for your wireless network and then press  on the control panel or remote 
control.
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 8. Use the down arrow button  on the control panel or remote to navigate to the Connect button.

 9. Select the Connect button and then press .

Network recommendations
The following are network recommendations:

 l Your document camera works best in an 802.11n/ac environment using a 5 GHz network. However, 
it will also connect to older routers such as the 802.11 b/g/n 2.4 GHz.

 l AES, TKIP, and AES+TKIP wireless encryption methods are supported. 

 l For WPA/WPA2 enterprise, the document camera only supports PEAP and not EAP-TLS, EAP-TTLS.

 l Minimum required WiFi bandwidth is 0.16 Mbps and maximum bandwidth can be as high as 4.8 
Mbps.

To get the most from your WiFi connection:

 l Set your router’s WiFi channel section to Auto.

 l Don’t use a Hidden WiFi network name.

 l Update your WiFi router to the latest firmware.

 l Check for sources of potential interference (microwave ovens, Bluetooth devices, faulty satellite 
television cables, power lines, cordless telephones, wireless speakers, flat-panel televisions, etc).

 l Please check with your System or Network Administrator to make sure that the ports are not blocked 
in the WiFi router. The TCP/UDP ports in use are as follows:

Port TCP/UDP Usage Descriptions

1900 UDP uPnP SSDP 
Package

For detecting and removing the document camera

9527 TCP Command To send/receive commands between an iPad and the 
document camera

9528 TCP Command To register connections for an occupied document camera

8557 TCP RTSP To connect to the RTSP Stream

Random RTP RTP For RTP connection

Random RTCP RTCP For RTCP connection
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Connecting your document camera to Miracast

Important 

 l You document camera must be connected to WiFi before you enable the Miracast setting.

 l Before setting up Miracast for the first time, make sure your document camera is connected to a 
display.

 l Press and hold the WiFi button on the control for 5 seconds to reconnect to the last Miracast 
receiver. Make sure that the Miracast mode is enabled.

To connect your document camera to Miracast

 1. Press the WiFi button  on the control panel.

The WiFi indicator light flashes orange.

 2. Press the MENU button on the control panel or remote control.

The OSD menu appears on your display.

 3. Use the right arrow button  on the control panel or remote control to navigate to the WiFi tab.

 4. Use the down arrow button  on the control panel or remote control to navigate to Wireless Mode 

and then press .

 5. Select Miracast and then press .

Access to the Miracast setup option is now available.

Important 

If the Miracast setup option is not available, check the document camera’s firmware version. The 
Miracast setup option is available only in firmware version 7 or higher.

To check the firmware version, access the System tab and then navigate to the Information. See 
Accessing the Setting menu on page 41.

 6. Use the down arrow button  to navigate to Miracast and then press .

 7. Select Setup and then press .

The Miracast Setting window appears.
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 8. Select your remote device from the Device drop down menu.

Note 

If you don’t see your remote device in the Device drop down menu, then use the Scan feature to 
search for your device. For more information on how to use the Scan feature, see Using the Scan 
feature to find connectable devices below.

 9. If required, enter the Pin Code for your document camera and then press .

 10. Navigate to Connect, and then press .

 11. Navigate to OK, and then press .

The document camera is now connected to Miracast.

Using the Scan feature to find connectable devices
Use the document camera’s Scan feature to search for devices that you can connect to the document 
camera using Miracast.

Important 

You must connect your document camera to WiFi before using the Scan feature.

To use the Scan feature to find connectable devices

 1. Complete steps 1-7 from Connecting your document camera to Miracast on the previous page.

 2. Use the down arrow button  on the control panel or remote control to navigate to Scan and then 

press .

 3. Navigate to the Device drop down menu and then press .
 4. Use the down arrow button  on the control panel or remote control to browse the list of 

connectable devices.
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Connecting to external devices
You can connect your document camera directly to the following external devices:

 l Microscope

 l Microphone

 l Speakers

Connecting your document camera to a microscope
Connect your document camera to a microscope to examine microscopic objects on a bigger screen.

To connect a microscope 

 1. Select the appropriate rubber coupler size for the microscope eyepiece and insert it in the 
microscope adapter.

 2. Attach the microscope adapter to the microscope eyepiece.

 3. Tighten the three bolts until the adapter secures the eyepiece.

 4. Attach the microscope adapter to the camera head.

 5. Connect the document camera to the microscope.

Important 

Make sure the arrow on the camera head and microscope adapter are on the same side. 
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 6. Turn the microscope adapter counterclockwise to line up the arrows and lock the microscope 
adapter in place.

To optimize microscope images

   1. Press the MENU button in the control panel, and then select the Image tab.

 2. Use the down arrow button  on the control panel or remote control to select the Mode sub-menu, 

and then press .

 3. Use the right arrow button  on the control panel or remote control to select the microscope 

option, and then press .

 4. Adjust and aim the camera head at the furthest point, and then press the AUTO FOCUS button on 
the control panel or remote control.

 5. Adjust the focus of the microscope.

 6. Connect the other end of the HDMI cable to the HDMI IN connector on your projector or display.

 7. Set the TV/RGB switch on the right-side connection panel to RGB.

Connecting your document camera to a microphone
You can connect an external microphone to your document camera.

Notes 

 l The built-in microphone on the control panel is disabled when an external microphone is 
connected.

 l The audio is in monophonic sound.

To connect speakers 

  Connect the microphone’s cable to the microphone on your document camera’s left-side 
connection panel.

Caution 

Turn the volume down to prevent hearing damage when using earphones.

Connecting your document camera to speakers
You can connect speakers to your document camera. Only audio from the video playback is supported.
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To connect a speakers

  Connect the speakers’ 3.5 mm cable to the speaker receptacle on your document camera’s left side 
connection panel.

Shooting area, overhead light, and anti-glare sheet

Shooting area
The shooting area can view a maximum area of 17 4/8" x 9 6/8" (44.5 cm x 24.8 cm).

To rotate the image

  Adjust the camera head to shooting area, and press ROTATE on the control panel or remote control.

To mirror the image

 1. Press the MENU button on the control panel, and then select the Image tab.

 2. Use the down arrow button  on the control panel or remote control to select MIRROR.

 3. Press  and select ON.

 4. Press the MENU button on the control panel to close the menu.

Overhead light
The camera head has a bright LED overhead light to enhance the lighting condition.

To power on the overhead light

  Press the LAMP button on your document camera’s control panel or remote control to power the 
overhead light on and off. 

Anti-glare sheet
The anti-glare sheet is a special coated film that helps eliminate any glare that could be encountered 
while displaying glossy objects, such as magazines and photos. Place the anti-glare sheet on top of an 
object to reduce reflected light.

Using the external memory storage
Your document camera supports an SD/SDHC card for image capture, audio, and video recording.
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Notes 

 l Your document camera support SD/SDHC cards from 1 GB up to 32 GB.

 l Recordings are in MP4 format.

 l An SDHC card with class-6 or higher is recommended for high-quality recording.

Your document camera detects when an external storage device is connected and automatically 
switches to the last detected storage. If no external storage device is connected, all captured images are 
saved in the built-in memory.

To insert an SD card

  Insert the card with the label facing up until it reaches the end and clicks into place. To remove the 
card, push to eject and pull the card out. 

Important 

Your document camera comes with piece of plastic inserted in the SD card slot. Remove this 
piece of plastic before you insert your SD/SDHC card.
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This chapter provides information on using your document camera and introduces you to the different 
camera modes.

Understanding Camera, Computer Pass-Through, 
and Playback modes
You can use your document camera in Camera, Computer Pass-Through, or Playback mode. Each 
mode enables you to complete different functions and requires a specific connection to either a display, 
a projector, or a computer. 

Camera mode
In Camera mode, you can view document camera images only in SMART Notebook software and 
SMART Document Camera software. 

Camera mode allows connection over a USB and live image output. You can view full-screen images 
from your document camera using a projector or high definition display without a computer. 
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Use SMART Notebook software to save images and then present them at a later time, or if your 
computer is connected to an interactive whiteboard, projector, or television, you can deliver your SMART 
Notebook presentation with live images from your document camera.

Note 

The Capture button on the control panel saves document camera images to the SMART Notebook 
page and closes the SMART Document Camera window. Pressing the Capture button again will re-
open the SMART Document Camera window. 

You can use the Camera mode’s on-screen display menu for greater control of the image. 

Computer Pass-Through mode
Computer Pass-Through mode switches your document camera’s video output to HDMI. You can switch 
between the live camera images and your computer screen images.

Notes 

 l The Capture button on the control panel has no effect in Computer Pass-Through mode.

 l In Computer Pass-Through mode, you can only view the document camera live image in SMART 
Notebook software.

Playback mode
In Playback mode you can view full-screen images and slide shows from the memory card on a 
projector or high-definition display without a computer. You can’t save images in Playback mode.

Features of each mode
The following table describes the differences between each mode. 

Feature description Camera mode Computer Pass-
Through mode

Playback mode

View computer input No Yes No

View document camera image Yes No No

View pictures from a memory card No No Yes

Access an internal memory and 
SD/SDHC card from the computer with 
a USB cable

Yes Yes No 
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Feature description Camera mode Computer Pass-
Through mode

Playback mode

Control the document camera from a 
computer

Yes Yes No

Capture to SMART Notebook software Yes No No

Capture to an SD/SDHC memory card Yes No No

Access the related on-screen display 
menu

Yes No No

Capture to a USB drive Yes No No

The following table describes outputs when your document camera is connected to a display with HDMI, 
USB, or Composite Video Out.

Feature description Camera mode Computer Pass-
Through mode

Playback mode

Connect to a projector or display (HDMI 
and USB output)

Camera image HDMI IN Memory card 
images

Connect to a USB output projector or a 
display

Camera image N/A Memory card 
images

Connect to a TV (composite video out) Camera image N/A Memory card 
images

Setting document camera modes

Setting your document camera to Camera mode
 1. Connect your document camera to your computer with the USB cable.

 2. Set the TV/RGB to RGB on the right side of the connection panel.

 3. Connect your document camera to a projector, monitor, or TV with an HDMI cable.

 4. Press the CAMERA/PC button on the control panel.

OR

Press the CAMERA button on the remote control.
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Setting your document camera to Computer Pass-Through mode
 1. Connect your document camera to your computer with the USB cable.

 2. Connect your computer with the HDMI cable to your document camera’s HDMI IN receptacle.

 3. Connect your display device with another HDMI cable to your document camera’s HDMI OUT 
receptacle.

 4. Press the CAMERA/PC button on the control panel or remote control.

OR

Press the PC 1/2 button on the remote control.

Setting your document camera to Playback mode
 1. Disconnect the USB cable from the rear connection panel.

 2. Connect your document camera to a projector or a monitor with the HDMI cable or to a TV with the 
composite video adapter cable.

 3. Press the PLAYBACK button on the control panel or remote control.

Displaying printed documents
When you set your document camera to Camera mode, you can display printed documents. Use the 
anti-glare sheet to reduce glare and optimize image quality. 

Displaying printed documents

To display printed documents

 1. Place your documents on the table.

 2. Adjust the document camera, and then aim its lens at your documents.

 3. Press AUTO FOCUS  on the control panel to adjust the focus. 

or

Press the AUTO FOCUS button on  the remote control to adjust the focus. 

Reducing glare
If glare makes it difficult for you to read the printed documents that you’re displaying, place the anti-
glare sheet on top of the documents. 
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Optimizing the image
 1. Set your document camera to Camera mode.

 2. Press the MENU button on the control panel or remote control.

The OSD menu appears.

 3. Press the right arrow  button on the control panel or remote control to navigate to the Image 

menu, and then press the  button on the control panel or remote control.

 4. Press the down arrow  button on the control panel or remote control to navigate to the Mode 

sub-menu, and then press the  button on the control panel or remote control.

 5. Press the right arrow  button on the control panel or remote control to navigate to Text mode
, and then press the  button on the control panel or remote control.

To optimize the camera for documents with graphics

 1. Set your document camera to Camera mode.

 2. Press the MENU button on the control panel or remote control.

The OSD menu appears.

 3. Press the right arrow  button on the control panel or remote control to navigate to the Image 

menu, and then press the  button on the control panel or remote control. 

 4. Press the down arrow  button on the control panel or remote control to navigate to the Mode 

sub-menu, and then press the  button on the control panel or remote control. 

 5. Press the right arrow  button on the control panel or remote control to navigate to Graphic 

mode , and then press the  button on the control panel or remote control.
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Using an SD/SDHC card
Your document camera has an SD/SDHC card slot on the right-side connection panel. You can save 
document camera images to an SD/SDHC card when your document camera is in Camera or 
Computer Pass-Through mode. When your document camera is in Playback mode you can display 
previously captured images from an SD/SDHC card. 

Caution 

Avoid static electricity near a card because it can cause damage.

Important 

Your document camera comes with a piece of plastic inserted in the SD/SDHC card slot. Remove this 
piece of plastic before you insert your SD/SDHC card.
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This chapter explains how to use your document camera in Camera mode.

Using Camera mode
When your document camera is connected to a projector, interactive display, or TV you can display a 
full-screen image from your document camera.

You can use your document camera in Camera mode to perform the following tasks:

 l Display objects.

 l Capture images to an SD/SDHC card.

 l Capture images to SMART Notebook software.

 l Use the features and settings in the OSD menu.

 l Use a microscope with a standard eyepiece and additional adapters.
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Important 

Your document camera must be connected to a display when using the OSD menu.

Switching to Camera mode
 1. Connect your document camera to a projector or flat-panel display with the appropriate cable.

 2. Press the CAMERA/PC button on the control panel. 

OR

Press the CAMERA button on the remote control. 

Displaying objects
 1. Press the CAMERA/PC button on the control panel. 

OR

Press the CAMERA button on the remote control. 

 2. Place the object you want to display under the camera. 

 3. Rotate the camera head to aim the lens at your object.

Recording a video

To record a video

 1. Insert an SD/SDHC card or USB drive into the appropriate receptacle.

 2. Press the RECORDING button on the control panel to start recording.

OR

Press the RECORD button on the remote control to start recording. 

To stop recording a video

  Press the FREEZE/STOP button on the control panel or remote control to stop recording.

Using the on-screen display menu in Camera mode
Use the OSD menu to adjust settings for your document camera in Camera mode.
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The following OSD menu options are available when your document camera is in Camera mode. 

Tab Options

Image Brightness, Contrast, Mode, Effect, Mirror, Advance, Focus

Presentation Spotlight, Visor, Split Screen, Picture in Picture (PIP), Timer, Miracast

Setting Capture, Storage, Format, USB to PC, Flicker, Saturation, Date/Time

WiFi AP, Dongle Mac ID, Current Status, Machine Name, Use Passcode

System Language, Output Display, Backup, Save Setting, Recall Setting, Information, 
Default

Navigating to the OSD menus and sub-menus in Camera mode
 1. Set your document camera to Camera mode.

 2. Press the MENU button on the control panel or remote control.

The OSD menu appears.

 3. Press the left  and right arrow  buttons on the control panel or remote control to toggle 
between tabs.

 4. Press the down  and up arrow  buttons on the control panel or remote control to choose a 
selection in the menu list.

 5. Press the  button on the control panel or remote control to make a selection.

 6. Press the  button on the control panel or remote control to enter a sub-menu.

 7. Press the  button on the control panel or remote control to return to the previous menu level.

 8. Press the MENU button on the control panel or remote control to exit the menu.

Accessing the Image menu
 1. Set your document camera to Camera mode.

 2. Press the MENU button on the control panel or remote control.

The OSD menu appears.
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 3. Use the right arrow  button on the control panel or remote control to navigate to the Image tab.

Image setting options Description

Brightness Adjust the image brightness level manually.

Contrast Adjust the image contrast level manually.

Mode Select an option from three image display settings:
 o  Text –  adjust the contrast to make text appear more 

visible. 
 o  Graphic –  adjust the gradient of image.
 o  Microscope –  adjust the optical zoom for microscopic 

view. 

Effect Convert the image to color, black/white, or film negative.

Mirror Select to flip the image:
 o ON – displays a mirrored image.
 o OFF – displays a normal image.

Advanced Adjust the advanced image settings:
 o Auto Image – Select to automatically adjust white balance and 

exposure, and to correct color and exposure compensation.
 o Exposure – Select the exposure settings:

 o AUTO – automatically adjust the camera exposure.
 o MANUAL – manually adjust the camera exposure.

 o White Balance –  Select the White Balance settings for various 
light conditions:
 o AUTO – automatically adjust the white balance.
 o MANUAL –  manually adjust the red and blue color levels. 

Focus Adjust the focus manually.

Accessing the Presentation menu
 1. Set your document camera to Camera mode. 

 2. Press the MENU button on the control panel or remote control.

The OSD menu appears.
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 3. Use the right arrow  button on the control panel or remote control to navigate to the 
Presentation tab. 

For WiFi and Miracast setup instructions see page 22.

Presentation setting 
options

Description

Spotlight Select to highlight an area on the presentation screen.
 o Set and move the overlay frame on the presentation screen. 
 o Select Execute to access the Spotlight sub-menu settings:

 o ON/OFF –  turn the Spotlight on or off. 
 o Shade – adjust the opacity level of the spotlight frame. 
 o Color –  select and change the color of the spotlight frame.

Visor Select to covers the presentation screen. The top part of the presentation 
screen remains slightly exposed. 
 o Use the arrow buttons on the control panel or remote control to 

adjust and move the covered area.
 o Select Execute to access the Visor sub-menu settings:

 o ON/OFF – Turn the Visor on or off.
 o Shade – Adjust the opacity level of the spotlight frame.

Split Screen Select to divide the screen into two parts. Half of the screen displays eight 
thumbnail images and the other half displays the image from your 
document camera.
 o Select the display location: left, right, top, or bottom.

 o Select OFF to cancel Split Screen.
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Presentation setting 
options

Description

Picture in Picture (PIP) Select to show captured pictures or videos as thumbnails in the corner of 
the screen in Camera mode. PIP displays an image from stored memory 
within the live camera image.
 o Select the thumbnail playback screen location: lower left, upper left, 

upper right, lower right.

 o Select OFF to cancel PIP. 

Note 

The PIP feature is for display only. You can’t capture an image while in 
PIP mode. 

Timer Select to control presentation time management. 
 o Start/Pause/Stop the timer.
 o Set the timer duration. 

Miracast Select Setup and enter device information to connect to Miracast.

Accessing the Setting menu
 1. Set your document camera to Camera mode.

 2. Press the MENU button on the control panel or remote control.

The OSD menu appears.
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 3. Press the right arrow  button on the control panel or remote control to navigate to the Setting 
tab. 

Setting options Description

Capture Select to set the capture resolution, quality, type, and interval 
settings. 
 o Resolution – select image capture size. In 2  M setting, the 

capture resolution is 1920 × 1080p.
 o Quality – select image quality: Finest, High, Normal.
 o Type – select image capture type:

 o Single – capture one picture at a time.
 o Continuous – capture consecutive pictures.

 o Interval – Set the time interval for continuous capture. The 
length can be up to 600 sec (10 min).

Storage  o Change the storage location. 
 o Audio and video recording can be saved only on an SD/SDHC 

card.

Format Delete all the data in the selected memory.

USB to PC Select the status of your document camera when it’s connected to 
the computer using a USB cable.
 o Camera – can be used as a computer webcam to record 

videos or capture images. 
 o Storage – transfer captured images or videos from the 

memory to a computer hard drive. 

Flicker Select refresh rate:
 o 50 Hz
 o 60 Hz

Saturation Adjust the saturation setting.

Date/Time Set the time and date.

Accessing the WiFi menu
 1. Set your document camera to Camera mode. 

 2. Press the MENU button on the control panel or remote control.

The OSD menu appears.
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 3. Press the right arrow  button on the control panel or remote control to navigate to the WiFi tab.

WiFi setting options Description

AP WiFi connection options:
 o WiFi Setup – Connect to a network by entering the IP 

information. 
 o ScanQR – Connect to a network by scanning the QR code. 
 o Advance – Import a certificate and choose whether to set a 

static IP. 

Dongle Mac ID Displays the connected WiFi dongle Mac ID. 

Current Status Displays the status of the connection mode. 

Machine Name Displays the name of your document camera, which you can select 
and change.

Use Password Select to enter a password for your document camera.

Accessing the System menu
 1. Set your document camera to Camera mode. 

 2. Press the MENU button on the control panel or remote control.

The OSD menu appears.

 3. Press the right arrow  button on the control panel or remote control to navigate to the System 
tab. 

System setting options Description

Language Select or change the language.
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System setting options Description

Output Display  o Set the resolution to display an image on the screen:
 o 1024 × 768
 o 1280 × 720
 o 1280 × 800
 o 1280 × 1024
 o 1600 × 1200
 o 1920 × 1080

 o Select TV System to switch between NTSC and PAL video 
systems.

Note 

This selection is disabled in TV output mode.

Backup Copy images and presentations from the built-in memory to an 
SD/SDHC card.

Save Setting Save current settings in the selected profile number. 

Note 

Only effect, mode, brightness, and contrast settings can be saved. 

Recall Setting Restore the setting to the selected profile number. 

Information Display the product information. 

Default Restore all the settings to the factory default settings. 

Capturing and transferring images and videos
You can capture images and videos from your document camera on an SD/SDHC card and transfer 
them to a computer.

Capturing images to memory
You can capture images and videos from your document camera to an SD/SDHC card when your 
document camera is in Camera mode. 

To capture images to memory

 1. Set your document camera to Camera mode (see Page 17). 

 2. Position your document camera.

 3. Adjust the camera settings using the Camera mode’s OSD menu (see Page 37).
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 4. Press the CAP/DEL button on the control panel.

OR

Press the CAPTURE button on the remote control.

Recording a video on an SD card
You can record a video with your document camera and save the recording to an SD card. 

To record a video on an SD/SDHC card

 1. Insert an SD/SDHC card in your document camera’s SD/SDHC card slot.

 2. Press the MENU button on the control panel or remote control.

The OSD menu appears.

 3. Press the  button on the control panel or remote control to navigate to the Setting tab.

 4. Press the  button on the control panel or remote control to navigate to the Storage, and then 

press the  button on the control panel or remote control.

The document camera detects the SD/SDHC card.

 5. Press the RECORDING button on the control panel to start recording.

OR

Press the RECORD button on the remote control to start recording.

 6. Press the RECORDING button on the control panel to stop recording.

OR

Press the RECORD button on the remote control to stop recording.

Transferring images to your computer
You can transfer images from your external storage device to your computer. 

To transfer images to your computer

 1. Use the OSD menu to set your document camera USB to PC mode and select STORAGE.

 2. Connect your document camera to your computer with the USB cable. See Page 17.
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 3. Adjust the camera settings using the Camera mode’s OSD menu. See Page 37.

Note 

Your computer recognizes your document camera and the external storage device as a removal 
disk.

 4. Browse to the removable disk on your computer, and then transfer the images to your computer.

Using a microscope
You can view the microscope stage through the document camera using additional attachments. See 
Connecting to external devices on page 26.

To display a microscope slide

 1. Place a slide or object on the stage of the microscope.

 2. Focus the microscope so that the subject is sharp.

 3. Position the microscope under your document camera so the camera lens is aligned with the 
microscope eyepiece.

Caution 

Ensure you do not hit your document camera lens with the microscope. This could damage your 
document camera’s lens.

 4. Press the CAMERA/PC button on the control panel.

Or

Press the CAMERA button on the remote control. 

 5. Press the MENU button on the control panel or remote control.

The OSD menu appears.

 6. Press the  button on the control panel or remote control to navigate to the Image tab. 

 7. Press the  button on the control panel or remote control to navigate to the Mode sub-menu, and 

then press the  button on the control panel or remote control.

 8. Press the  button on the control panel or remote control to navigate to the Microscope mode and 

then press the  button on the control panel or remote control.
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This chapter explains how to use your document camera in Playback mode.

Setting your document camera to Playback mode
When you set your document camera to Playback mode, you can connect to a display or a projector and 
play back the images or videos from an SD/SDHC card or the internal memory. Browse through the 
stored images and display captured images individually or as a slide show.

Note 

When your document camera is in Playback mode, connect to a display or projector using an HDMI 
cable and ensure that the images you want to show are stored using an internal or external memory 
source.

Setting your document camera to Playback mode
While in Playback mode the document camera uses the video output, which disables your ability to 
access live images and USB functions.
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Setting Playback mode using an SD/SDHC card
 1. Connect your document camera to a display or projector. See Connecting to different displays on 

page 19.

 2. Insert an SD/SDHC card into your document camera. See Using an SD/SDHC card on page 35.

 3. Press the PLAYBACK button on the control panel or remote control.

Using the OSD menu in Playback mode
Use the Playback mode OSD menu to view and select your source storage location and control how the 
stored images are displayed.

Navigating the OSD menu in Playback mode

To navigate the OSD menu in Playback mode

 1. Insert an SD/SDHC card into the document camera. 

 2. Set your document camera to Playback mode. Press the PLAYBACK button on the control panel or 
remote control. 

 3. Press the MENU button on the control panel or remote control. 

The OSD menu appears. 

 4. Press the left  and right arrow  buttons on the control panel or remote control to navigate 
between functions in the menu list. 

 5. Press the down  and up arrow  buttons on the control panel or remote control to choose a 
selection in the menu list. 

 6. Press the  button on the control panel or remote control to make a selection. 

 7. Press the  button on the control panel or remote control to enter a sub-menu.

 8. Press the  button on the control panel or remote control to return to the previous menu level.

 9. Press the MENU button on the control panel or remote control to exit the menu.
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Using Playback mode OSD menu options
The following OSD menu options are available when your document camera is in Playback mode.

Playback menu option Description

Slide Show Displays all captured still images in an automated slide show.

Interval Set the slide show interval before displaying the next image. The 
maximum interval is 100 seconds.

Effect Select the slide show transition effect:

 l Slide image
 l Checker down
 l Blinds
 l Split Vertical Out 
 l Split Horizontal In

Storage Select the source of the images.

Delete All Permanently deletes all the data in the selected memory source.

Note 

A warning message appears. Select YES to continue or NO to stop.

Selecting the settings for a slide show
 1. Press the MENU button on the control panel or remote control to access the Playback mode OSD 

menu. 
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 2. Press the down arrow  button on the control panel or remote control panel to make a selection, 

and then press the  button.

 3. Press the left  and right arrow  buttons on the control panel or remote control to toggle 
between functions.

 4. Press the  button on the control panel or remote control to toggle between functions.
 5. Press the MENU button on the control panel or remote control to close the menu.

Playing a slide show
 1. Connect your document camera to a projector or display (see Page 19).

 2. Insert an SD/SDHC card. 

 3. Press the PLAYBACK button on the control panel or remote control. 

Thumbnail images from the memory source are displayed.

 4. Press the MENU button on the control panel or remote control. 

 5. Press the  button on the control panel or remote control twice to start the slide show.

 6. Press the MENU button on the control panel or remote control to stop the slide show or to return to 
thumbnail view. 

Playing a video
 1. Connect your document camera to a projector or display (see Page 19).

 2. Insert an SD/SDHC card. 

 3. Press the PLAYBACK button on the control panel or remote control.

Thumbnail images from the memory source are displayed.

 4. Press the left  and right arrow  buttons on the control panel or remote control to toggle 
between images.

 5. Press the  button on the control panel or remote control to select the video you want to play.

 6. Press the MENU button on the control panel or remote control to stop the video or to return to 
thumbnail view.

Deleting images
You can delete all images at once from your document camera’s memory sources using the OSD menu, 
or you can delete selected images.
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Important 

You are unable to delete images from your computer in Playback mode. You can delete images only 
from the connected memory source.

To delete all images

 1. Select the memory source you want to delete all images from. 

 2. Press the MENU button on the control panel or remote control to access the Playback mode OSD 
menu.

 3. Press the down arrow  button the control panel or remote control to navigate to DELETE ALL. 

 4. Press the  button on the control panel or remote control to make a selection. 

The DELETE ALL warning appears. 

 5. Press the left  and right arrow  buttons on the control panel or remote control to select YES or 
NO. 

 6. Press the MENU button on the control panel or remote control to DELETE or CANCEL.

 7. Press the MENU button on the control panel or remote control to close the Playback mode OSD 
menu. 

To delete one image

 1. Press the PLAYBACK button on the control panel or remote control to display all the images in the 
memory storage.

 2. Press the right , left , down , or up arrow  buttons on the control panel or remote control 
to select the image you want to delete. 

 3. Press the CAP/DEL button on the control panel.

The DELETE THIS IMAGE warning appears. 

OR

Press DEL on the remote control. 

The DELETE THIS IMAGE warning appears. 

 4. Press the left  and right arrow  buttons on the control panel or remote control to select YES or 
NO.

 5. Press the MENU button on the control panel or remote control to DELETE or CANCEL.

 6. Press the MENU button on the control panel or remote control to close the Playback mode OSD 
menu.
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This chapter explains how to use your document camera with SMART Notebook collaborative learning 
software and SMART Document Camera software. 

Using your document camera with SMART Notebook and SMART Document Camera software enables 
you to display and capture images/videos.

Important 

 l SMART Notebook software is compatible only through a wired connection.

 l Make sure your document camera is set to Camera or Computer Pass-Through mode when 
using SMART Notebook software.

 l SMART Document Camera software is available through a wireless and wired connection.

Connecting your document camera to SMART 
Notebook software
 1. Connect your document camera to your computer using the provided USB cable.

 2. Power on the document camera.

 3. Launch SMART Notebook software.

 4. Select Insert from the main menu and then select SMART Document Camera Viewer.

The SMART Document Camera window appears.

 5. Place the object you want to display under the camera.
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Navigating SMART Notebook’s Document Camera 
Viewer menu options
Once the SMART Document Camera Viewer is launched in SMART Notebook, you can easily capture 
images with the document camera and then adjust them in SMART Notebook's SMART Document 
Camera window. 

The following options are available in the SMART Document Camera window.

Option Description

Mixed Reality Note 

The Mixed Reality feature is only compatible with SMART Document Camera 
450 and earlier models. 

Capture and close Insert a screen capture on the current Notebook page and then close the 
window.

Capture to new 
page

Capture an image and insert it on a new Notebook page while keeping the 
current window open.

Capture with time-
lapse 

Capture a series of screen captures. 

Zoom out Decrease the image magnification. 

Zoom in Increase the image magnification.

Decrease 
brightness

Decrease the level of brightness when capturing images. 

Increase brightness Increase the level of brightness when capturing images. 

Auto focus Automatically adjust focus.

Focus out Focus out manually. 

Focus in Focus in manually. 

Additional settings  l Start Microscope Mode
 l Stop Microscope Mode 
 l Rotate 180 degrees
 l Convert to Color
 l Convert to Black and White
 l Convert to Positive 
 l Convert to Negative
 l Automatically Start Mixed Reality Tools
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Using a microscope with SMART Notebook software
 1. Connect your document camera to your computer. See Connecting to external devices on page 26.

 2. Open the SMART Document Camera window.

 3. Press Additional Settings on the SMART Document Camera window menu bar, and then select 
Start Microscope Mode.

 4. Press Additional Settings, and then select Stop Microscope Mode when you’re done.

Connecting your document camera to SMART 
Document Camera software
 1. Power on the document camera.

 2. Launch SMART Document Camera software.

 3. Select the SMART menu on the top left corner and select Options.

 4. Navigate to the Camera Setting tab. 

 5. Select My WirelessCam from Choose type of Wireless Camera.

 6. Select the IP button. 

 7. Enter your IP information and select OK.

Important 

Ensure your computer is connected to the same WiFi network (SSID) as the document camera.

 8. Select the OK button to apply the updates.

 9. Place the object you want to display under the camera.

For more information on network recommendations see Connecting to a wireless network on page 22.

To connect to SMART Document Camera software using a wired connection

 1. Connect your document camera to your computer using the provided USB cable.

 2. Power on the document camera.

 3. Launch SMART Document Camera software.

 4. Place the object you want to display under the camera.
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Navigating SMART Document Camera software’s 
Viewer menu options
Once your document camera is connected to SMART Document Camera software you can easily 
capture and adjust images.

The following options are available in the SMART Document Camera Viewer window.

Option Description

Camera Control  l Pause
 l Auto focus
 l Auto adjust
 l Zoom in 
 l Zoom out
 l Zoom reset
 l Rotate right
 l Rotate left
 l Image adjustments

 o Brightness
 o Contrast
 o White balance
 o Manual focus
 o Exposure 
 o Straighten image
 o Color effect
 o Mode
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Option Description

Annotation  l Select
 l Freehand
 l Highlighter
 l Line
 l Text
 l Shape
 l Eraser
 l Clear all
 l Colors
 l Line style
 l Undo
 l Redo

Recording  l Record
 l Pause
 l Mute
 l Slow motion mode

Capture  l Capture
 l HD capture
 l Area capture
 l Continuous capture

Widget Mode  l Camera control
 l Record
 l Capture
 l Camera capture
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This chapter provides troubleshooting information for your document camera.

Notes 

 l These procedures vary depending on your Windows operating system and your system 
preferences.

 l SMART recommends that you update or re-flash the firmware in your document camera to the 
latest version when there is a new release or if you encounter operational issues, such as lack of 
Wi-Fi connectivity, difficulty starting, or other issues. For more information, see Updating or re-
flashing the SMART Document Camera 550.

https://community.smarttech.com/s/article/How-to-update-or-re-flash-the-SMART-Document-Camera-550?language=en_US
https://community.smarttech.com/s/article/How-to-update-or-re-flash-the-SMART-Document-Camera-550?language=en_US
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Resolving general issues
Issue Solutions

The presentation screen is 
dark and unreadable 

 l Turn on Auto Image in your document camera’s OSD menu (Menu 
> IMAGE > Advanced > Auto Image) to adjust the image 
brightness. 

 l Reset your document camera to its default settings (Menu > 
SYSTEM > Default > Yes > Enter). 

 l Make sure there’s enough light in the room, or turn on the 
overhead light on your document camera.

 l Adjust the brightness and contrast levels manually in the document 
camera’s OSD menu, or use the buttons on the control panel or 
remote control.

Note 

Ensure the display settings are not adjusted from the default 
settings.

 l If you are using a projector, check the bulb.

The SD/SDHC card does not 
play videos properly.

  Format the SD/SDHC card using the document camera’s OSD 
menu (Menu > SETTING > Format > SD CARD).

Caution 

This erases all the data on the SD/SDHC.

Your document camera has 
an issue not described 
above.

  Restart the document camera using the power button on the 
control panel or remote control.

Resolving image issues
Issue Solutions

No camera image displays 
while in Camera mode.

 l Ensure your document camera is turned on.
 l Check all cable connections.
 l Check the TV/RGB switch on the right-side connection panel of 

your document camera and set it to the type of display device you 
have. 

 l Reset the output resolution by using a pen tip or other small object 
to press the resolution reset button on the left panel of the 
document camera.
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Issue Solutions

No computer image displays 
while in Computer Pass-
Through mode.

 l Ensure your document camera is turned on.
 l Ensure the your computer is working by plugging it directly into the 

display.
 l Check all cable connections.
 l Check the cable connections from the computer HDMI output to 

the HDMI input of your document camera.
 l Ensure your document camera is in Computer Pass-Through 

mode.
 l On some computers, you can press FN+F5 repeatedly to toggle 

between display modes and the computer images on the 
presentation screen. 

No image appears when you 
press the PLAYBACK button.

 l Insert an SD/SDHC card with stored images or capture an image 
to the internal memory. 

 l Disconnect the USB cable. 

Note 

Images need to be stored in the available memory location in 
order to enter Playback mode.

The image on the 
presentation screen is 
distorted or blurry.

 l Reset your document camera to its default settings (Menu > 
SYSTEMS > Default > Yes). 

 l Adjust the brightness and contrast manually to reduce the 
distortion. 

 l Press the auto focus button on the control panel or remote control 
to adjust the image.

Resolving software issues
Issue Solutions 

SMART Notebook software or 
SMART Document Camera 
software doesn’t detect your 
document camera.

 l Ensure your USB cable is connected.

Note 

If you are not directly connected through a single USB cable, use 
a shorter direct connection.

 l Ensure your software is up-to-date.
 l Ensure the USB cable and the computer USB receptacle are 

working properly.
 l Ensure the USB to PC setting is set to CAMERA in the document 

camera’s OSD menu.
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Resolving recording issues
Issue Solutions 

You’re unable to record a 
video (the red recording light 
doesn’t turn on).

 l Ensure the SD/SDHC card is installed.
 l Disconnect the USB cable (the document camera doesn’t record 

video while being used as a USB camera).

The document camera stops 
responding during video 
recording.

  Format the SD/SDHC card or USB drive using the document 
camera’s OSD menu (Menu > SETTING > Format > SD CARD).

Caution 

This erases all the data on the SD/SDHC.

Resolving connection issues
Issue Solutions 

The WiFi connection shows 
None on the OSD menu.

 l Ensure the WiFi dongle is inserted into the document camera.
 l Ensure the WiFi router is operating.
 l Rescan for the WiFi signal (Menu > WiFi > Advanced >  Rescan).

The document camera is 
connected to my computer 
but I cannot see the live 
image in the SMART 
Document Camera Viewer 
window.

 l Ensure the WiFi LED indicator on the document camera control 
panel is off.

 l If the WiFi LED indicator is on, press the  button on the control 
panel to turn it off. Then reopen the document camera software.

The SMART Document 
Camera software detects 
and displays the IP address 
but is unable to detect your 
document camera on the 
Options page.

 l Ensure your computer is connected to the same WiFi network 
(SSID) as the document camera.

 l If your computer and document camera are not connected to the 
same network rescan and connect the document camera. (SMART 
> Options > Camera Setting > IP).
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Certification and compliance

Federal Communication Commission 
Interference Statement
This device complies with Part 15 of the FCC Rules. Operation is 
subject to the following two conditions:

 1. This device may not cause harmful interference, and
 2. this device must accept any interference received, 

including interference that may cause undesired 
operation. 

This equipment has been tested and found to comply with the 
limits for a Class B digital device, pursuant to Part 15 of the FCC 
Rules. These limits are designed to provide reasonable 
protection against harmful interference in a residential 
installation. This equipment generates, uses and can radiate 
radio frequency energy and, if not installed and used in 
accordance with the instructions, may cause harmful 
interference to radio communications.
However, there is no guarantee that interference will not occur 
in a particular installation. If this equipment does cause 
harmful interference to radio or television reception, which can 
be determined by turning the equipment off and on, the user is 
encouraged to try to correct the interference by one of the 
following measures:

 l Reorient or relocate the receiving antenna. 
 l Increase the separation between the equipment and 

receiver. 
 l Connect the equipment into an outlet on a circuit 

different from that to which the receiver is connected.
 l Consult the dealer or an experience radio/TV technician 

for help. 

Caution 
Any changes or modifications not expressly approved by 
the party responsible for compliance could void the user’s 
authority to operate this equipment. 
This transmitter must not be co-located or operating in 
conjunction with any other antenna or transmitter. 
For operation within 5.15 ~ 5.25GHz / 5.47 ~5.725GHz 
frequency range, it is restricted to indoor environment. The 
band from 5600-5650MHz will be disabled by the software 
during the manufacturing and cannot be changed by the 
end user. This device meets all the other requirement 
specified in Part 15E, Section 15.407 of the FCC Rules. 

FCC Radiation Exposure Statement:

This product complies with the FCC portable RF exposure limit 
set forth for an uncontrolled environment and are safe for 
intended operation as described in this manual. Reduce RF 
exposure further by keeping the product as far as possible 
from your body and by setting the device to a lower output 
power (if  available).

Innovation, Science, and Economic 
Development Canada Statement
This device complies with RSS-210 of the Industry Canada 
Rules. Operating is subject to the following two conditions:

 1. This device may not cause harmful interference, and
 2. this device must accept any interference received, 

including interference that may cause undesired 
operation.

Ce dispositif est conforme à la norme CNR-210 d’Industrie 
Canada applicable aux appareils radio exempts de licence. 
Son fonctionnement est sujet aux deux conditions suivantes:

 1. le dispositif ne doit pas produire de brouillage 
préjudiciable, et

 2. ce dispositif doit accepter tout brouillage reçu, y compris 
un brouillage susceptible de provoquer un 
fonctionnement indésirable.

Caution 

 i. the device for operation in the band 5150-5250 MHz 
is only for indoor use to reduce the potential for 
harmful interference to co-channel mobile satellite 
systems;

 ii. the maximum antenna gain permitted for devices in 
the bands 5250-5350 MHz and 5470-5725 MHz shall 
comply with the e.i.r.p. limit; and

 iii. the maximum antenna gain permitted for devices in 
the band 5725-5825 MHz shall comply with the e.i.r.p. 
limits speci"ed for point-to-point and non point-to-
point operation as appropriate.

 iv. Users should also be advised that high-power radars 
are allocated as primary users (i.e. priority users) of 
the bands 5250-5350 MHz and 5650-5850 MHz and 
that these radars could cause interference and/or 
damage to LE-LAN devices.

Avertissement:
Le guide d’utilisation des dispositifs pour réseaux locaux doit 
inclure des instructions précises sur les restrictions 
susmentionnées, notamment :
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 i. les dispositifs fonctionnant dans la bande 5 150-5 250 
MHz sont réservés uniquement pour une utilisation à 
l’intérieur a"n de réduire les risques de brouillage 
préjudiciable aux systèmes de satellites mobiles utilisant 
les mêmes canaux;

 ii. le gain maximal d’antenne permis pour les dispositifs 
utilisant les bandes 5 250-5 350 MHz et 5 470-5 725 MHz 
doit se conformer à la limite de p.i.r.e.;

 iii. le gain maximal d’antenne permis (pour les dispositifs 
utilisant la bande 5 725-5 825 MHz) doit se conformer à 
la limite de p.i.r.e. spéci"ée pour l’exploitation point à 
point et non point à point, selon le cas.

 iv. De plus, les utilisateurs devraient aussi être avisés que les 
utilisateurs de radars de haute puissance sont désignés 
utilisateurs principaux (c.-à-d., qu’ils ont la priorité) pour 
les bandes 5 250-5 350 MHz et 5 650-5 850 MHz et que 
ces radars pourraient causer du brouillage et/ou des 
dommages aux dispositifs LAN-EL.

Radiation Exposure Statement:
This product complies with the Canada portable RF exposure 
limit set forth for an uncontrolled environment and is safe for 
intended operation as described in this manual. Reducer RF 
exposure further by keeping the product as far as possible 
from your body and by setting the device to a lower output 
power (if available).
Déclaration d'exposition aux radiations:
Le produit est conforme aux limites d'exposition pour les 
appareils portables RF pour les Etats-Unis et le Canada 
établies pour un environnement non contrôlé.
Le produit est sûr pour un fonctionnement tel que décrit dans 
ce manuel. La réduction aux expositions RF peut être 
augmentée si l'appareil peut être conservé aussi loin que 
possible du corps de l'utilisateur ou que le dispositif est réglé 
sur la puissance de sortie la plus faible si une telle fonction est 
disponible.

EU Declaration of Conformity
Hereby, SMART Technologies ULC declares that the ratio 
equipment type Wireless AC Dual Band Adapter, DWA-171 is an 
compliance with Directive 2014/53/EU. The full text of the EU 
declaration of conformity is available at the following internet 
address: www.smarttech.com/compliance.

Warning 
This equipment is compliant with Class A of CISPR 32. In a 
residential environment, this equipment may cause radio 
interference.

The frequency band and the maximum transmitted power in 
EU are listed below:

Transmitting Band 
(MHz)

Maximum Transmit Power EIRP 
(dBm)

2400-2483.5 19.85

5150-5350 19.45

5470-5725 17.44

Restrictions in (5GHz)
AT/BE/BG/CZ/DK/EE/FR/DE/IS/IE/IT/EL/ES/CY/LV/LI/LT/LU/
HU/MT/NL/NO/PL/PT/RO/SI/SK/TR/FI/SE/CH/UK/HR. 
5150MHz-5350MHz is for indoor use only.

Caution: EXPOSURE TO RADIO FREQUENCY 
RADIATION

This equipment complies with EU radiation exposure limits 
set forth for an uncontrolled environment. This equipment 
should be installed and operated with minimum distance 
20 cm between the radiator and your body.

Hardware environmental compliance
SMART Technologies supports global efforts to ensure that 
electronic equipment is manufactured, sold, and disposed of in 
a safe and environmentally friendly manner.

Waste Electrical and Electronic Equipment 
regulations (WEEE and Battery Directive)
Waste electrical and electronic equipment and batteries 
contain substances that can be harmful to the environment 
and to human health. Products should be disposed of in the 
appropriate recycling stream and not as regular waste.

Batteries
The SMART Document Camera 550 contains rechargeable 
lithium batteries. The remote contains two AAA batteries. 
Recycle or dispose of batteries properly.
See smarttech.com/compliance for more information.

Hazardous Materials Table
In accordance with the previsions of SJ/T 11364, visit 
smarttech.com/compliance for this product's hazardous 
material table.

https://smarttech.com/compliance
https://smarttech.com/compliance
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SMART Technologies
smarttech.com/support

smarttech.com/contactsupport

https://www.smarttech.com/support
https://www.smarttech.com/contactsupport
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